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Introduction to Tables

Communicating data clearly and effectively

Division | Sales USD (MM) | Contribution % | Target (MM) Target %
APAC 483,568 321% 500,000 (3.3%)
EMEA 359,474 23.8% 350,000 2.7%
Americas 665,455 44.1% 600,000 10.9%
1,508,497 1,450,000 4.0%

Precise alignment and greater flexibility when edits need to be made
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Go to the ‘Insert’ Tab
and select ‘Table’

OR

Table Shortcut

D-o-m

Insert Draw Design Transitior

H| & @)
Table Pictures Screenshot Photo
v o ¥ Album v

5x3 Table

oO0000d

@ Insert Table...

A drop-down menu will
appear with a grid

Move your mouse of the
squares to select the number
of rows and columns you want
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@ Insert Table...

E{l Draw Table

Go to the ‘Insert’ Tab
and select ‘Table’

Click on the ‘Insert Table’

Cancel

OR E Excel Spreadsheet
Insert Table ? !
. o+ . o= . Number of columns: 5 (3]
Number of rows: ‘2 i—;—“
Table Shortcut

Enter the number of rows
and columns manually
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Table Design
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File  Home Insert Draw Design Transitions Animations Slide Show Record Review View Add-ins Help Acrobat ITabIe Designl Table Layout

[v] Header Row [ First Column Shading ¥ A~ | N E:L-l/ e
__________ v A . v
[ Total Row Otastcomn || 55555 | S5=a= Borders Quick &= [ 1t | Draw Eraser
[] Banded Rows [ ] Banded Columns [ & Effects Stles¥ A v [ZrpenColorv Table
Tablo Styla Ontis W 5 o, Rord,

Table style options

Design styles

Further aesthetic customization
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Table Layout

File Home Insert Draw Design Transitions Animations Slide Show Record Review View Add-ins Help Acrobat Table Design [Table Layout

1] Height: [412cm T

% @ %‘( ﬁ ﬁ @ @ % @ I]] Height: ‘1.03 cm : ‘ DI Distribute Rows @ g llﬁ @
width: [2258cm |
View Delete = Insert Insert Insert Insert Split (=T ~ e Text Cell 2 N - ha
Width: |5.64 Distribute Col
Gridlines' Above Below Left Right Cells s V! ‘ U ‘ £ Distribute Columns EHE Direction v Margins ¥ |l [] Lock Aspect Ratio
Table 4 callsi Al - Zable si
| : |

Customize cell Alignment of
and table size information

FINANCIALEDGE!

Merge or
split cells

Add and
delete cells

e &y

Inserting a Table from Excel
using Paste Special
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Supporting Data
from Excel

Automatic
updates

Insert Data into
PowerPoint
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In Excel, open the saved
workbook with the data you
want to insert and link to

Drag over the area of
data you want to link to
in PowerPoint and
press CTRL+C

In PowerPoint, click the slide
where you want to paste the
copied worksheet data
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File  Home Insert

[z S

Paste

&f

Paste Options:
2 7 [

Paste Special...

On the Home tab, click the
arrow below Paste and
select Paste Special

Paste Special

Source: Microsoft Excel Worksheet (code)
WorkoutlR2C1:R19C2

(O Display as icon

Result
Inserts a picture of the diipboard contents into your presentation. Paste
Link creates a shortcut to the source file so that changes to the source
sla]3) file will be reflected in your presentation.

Cancel

In the Paste Special box, click Paste link,
and then, under As, select Microsoft
Excel Worksheet Object
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&
@ copy
New Customers Prior Month (B paste Options:

Monthly Growth Rate of New C Qo
Monthly Churn Rate ﬁ -

Starting MRR Linked Macro-Enabled Worksheet Object >

Price of Subscription [ Update Link

Expansion MRR
Contraction MRR

T Bring to Front >

# Customers - Beginning | B2 send to Back N
New Customers
Lost Customers & Lok
# Customers - Ending @ Link >
Prior Month MRR Save as Picture...
New MRR B3 View Alt Text..
Lost MRR {

- < Format Object...
Ending MRR
ARR \ ¥ New Comment )

Right-click on the table and
select ‘Update Link’ if the values
change in Excel
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File

Home

Insert  Draw  Design  Transitions  Animations  Slide Show  Review  View  Help  Acrobat [ Table Design| Layout @ Share Comments
¥ HeaderRow  [_] First Column - A - _— Eﬁ [[0
[ Total Row [] Last Column Quick A~ e ¥| Draw  Eraser
Styles ~ Table
[v] Banded Rows ~ [| Banded Columns A~ Z Pen Color v
Table Style Options Table Styles WordArt Styles. o Draw Borders A
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Table Design Tab

Change the appearance of your table

Division Sales USD (MM) | Contribution % | Target (MM) | Target %
APAC 483,568 321% 500,000 (3.3%)
EMEA 359,474 23.8% 350,000 2.7%
Americas 665,455 44.1% 600,000 10.9%
1,508,497 1,450,000 4.0%
FINANCIALEDGE!
Gallery of styles Customize style

(“ooors )" sorcers | smaaing | evts )

Using the Shading,
Borders, and
Effects buttons

File Home Insert

Draw Design Transitions Animations Slide phow Review View Help Acrobat Table Design Layout & Share 3
| Header R ¥ First Col A . _—
e sl Ml s S mess pm=mm gmses [gEmms| gems= soces gess= | (£ A = B
=== f==== EN==== |[E====| p==== E=== p==== l:
Wimdie W s muun Qewss Qesss |fes=s] f==== §--——- j==== = Qe &~ 3P |*| Draw Eraser
Styles v Table
[] Banded Rows ~ [[] Banded Columns =/ £ Pen Color
Table Style Options Table Styles WordArt Styles N Draw Borders
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Header Row

Show or hide the first row of your table

Column headings

File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout 2 Share 7
Header Row First Column v ,A/ A - — EE/j E‘:O
[ Total Row [] Last Column v Quick A~ 3pt B 6 ey
Styles v Table
[v] Banded Rows [ ] Banded Columns =/ v IZ Pen Color v
Table Style Options Table Styles WordArt Styles 15 Draw Borders
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.
Show or hide the last row of your table
Summary or total values
File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout & Share 3
[ Header Row ¥ First Column A - - E:/j Eo
[] Total Row [ Last Column = Quick A - 3 premmm—— v bW Eraser
- Styles v Table
[] Banded Rows  [[] Banded Columns 9 A~ 2 Pen Color v
Table Style Options Table Styles WordArt Styles 1 Draw Borders
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Banded Rows

To apply alternating colors to the rows of your table

File Home Insert Draw

Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout 2 Share 7
[¥] Header Row First Column N A/ A _ EE/j EO
[ Total Row [] Last Column — v Quick A~ 3pt B 6 ey
. Styles v Tabl
Banded Rows [ | Banded Columns = v Z Pen Color v e
Table Style Options. Table Styles WordArt Styles N Draw Borders
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First Column
. o
Show or hide the first column of your table
Row labels
File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout & Share 3
[ Header Row M First Column v y & — E:A/j D—_Aoj
["] Total Row [ Last Column v Quick A - 3 premmm—— v bW Eraser
Styles Table
[] Banded Rows  [[] Banded Columns 9 A~ 2 Pen Color v
Table Style Options Table Styles WordArt Styles N Draw Borders
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Last Column

Show or hide the last column of your table

Final or subtotal values

File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout 2 Share 7
[] Header Row First Column v A/ A - | EE/j EO
[ Total Row [ Last Column — v Quick A~ 3pt B 6 ey
- Styles v Table
[v] Banded Rows [ ] Banded Columns v Z Pen Color v
Table Style Options Table Styles WordArt Styles 5 Draw Borders
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.
To apply alternating colors to the columns of your table
.
Easier to compare
File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout & Share 3
[V] Header Row ¥ First Column y A - —_ E:/j on
["] Total Row [ Last Column Quick A - 3 premmm—— v bW Eraser
Styles v Table
[] Banded Rows [_] Banded Columns 9 A~ 2 Pen Color v
Table Style Options Table Styles WordArt Styles s Draw Borders
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File Home

& [EH

Select | View

Insert  Draw  Design Transitions

@ ﬁ FA Insert Below

Animations Slide Show

H H | o

Review View

Help  Acrobat  Table Design

Delete Insert & Insert Left

o) oot

& Share

3 Commen

= = = u/j @ 1M Height: 59 cm (=}
(=l ~
Merge  Split Text Cell TIwidth: 2073cm T | Amange
Gridlines v Above Cells Cells = SH Direction v Margins v it
| HE Insert Right ~ [ g0 8 = [7] Lock Aspect Ratio
Table Rows & Columns Merge Cell size | Alignment Table Size
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Table Layout

Change the structure of data in your table

Division Sales USD (MM) | Contribution % | Target (MM) | Target %
APAC 483,568 32.1% 500,000 (3.3%)
EMEA 359,474 23.8% 350,000 2.7%
Americas 665,455 44.1% 600,000 10.9%
1,508,497 1,450,000 4.0%
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Rows &

Select multiple
rows or columns

@ x

File Home Insert Draw esign Transitions Animations Slide Show Review View Help Acrobat Table Design

Columns

Add or delete rows
and columns

Layout
b B Insert Below % @ . N — = A T Height: 5 cm

N = | Mhen 2| OF = BN = A
S

Select | View Delete Insert & Insert Left Merge  Split Text Cell 3 width: |25 cm

Gridlines v Above Cells Cells Hsosem 0| H Direction ¥ Margins v
B Insert Right i ~] = [l =2 = J ["] Lock Aspect Ratio
Table Rows & Columns Merge Cell Size Alignment Table Size
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File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout
] = cm -
N EH £S5, Ehy B insertselon ==} I==! || D o) m == = | [ 1 Height: 5 :
Select | View Delete Insert  &H Insert Left Merge | Split Text cell Slwidth: 25cm ]
v Gridlines < Above Tt Cells || Cells 3505cm H [FE] [E [& Directionv Margins ¥ L ——
Table Rows & Columns Merge Cell Size Alignment Table Size
Merge Split
Combine two or .
. Split merged cells
more adjacent cells
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File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Design Layout

] = cm -

N EH £S5, Ehy B insertselon B H e || == = | [ 1 Height: 5 :

Select | View Delete Insert ~ &H Insert Left Merge  Split Text Cell TIwidth: 25cm

v Gridlines < Above Tt Cells  Cells 3505cm H [FE] [E [& Directionv Margins ¥ L ——
Table Rows & Columns Merge Cell Size Alignment Table Size
L] L] o
Cell Size Distribute
Adjust the height and Evenly space cells
width of your table cells horizontally or vertically
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Align Text or Values

Left, center, or right
alignment options

File Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Tdble Design Layout
<= f ) Hil|
EH Insert Below % @ . _ _ A Height: 5 cm -
s B | BED BE B Te oo | = BN =l L
Select | View Delete Insert & Insert Left Merge  Split Text Cell Swidth: 25cm ]
v Gridl v Ab Cell Cell 505 B E ction ¥ M v
il 2 HZ Insert Right = o M ol 8 B SRyection L [] Lock Aspect Ratio
Table Rows & Columns Merge Cell Size Alignmen| Table Size
Vertical Positioning
Text to be closer to the top,
center, or bottom of each cell
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Text Direction
Change the
o o
orientation of the text
File Home Insert Draw Design Transitions Animations Slide Show Review View Help Afrobat Table Design Layout
<1 EA Insert Below % @ . _ — _ A 1 Height: |5 cm -
s BJ  E B8 B e oom || = IS =GN [ || © :
Select | View Delete Insert ~ &H Insert Left Merge  Split Text cell TIwidth: 25cm
v Gridlines v Above e Cells  Cells =505 cm B [F] [E [E Direction~ Margins v T
Table Rows & Columns Merge Cell Size Alignn| ABC Table Size
Rotate all text 90°
R Il text 270°
& otate all text
A
Stacked
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Margins

Change the amount of space
between the text and the cell edges

File

Home Insert Draw Design Transitions Animations Slide Show Review View Help Acrobat Table Dgsign Layout
Ak EH Insert Below . _ — _ A 10 Height: |5 cm
[} EEE Dj;‘ e M1em 0t = = = i b
. &H Insert Left S width: 25 cm
Select  View Delete Insert Merge  Split Text Cell pamrd
v Gridlines v Above Cells Cells Hisosem 0 H Direction ¥ Margins ¥
H Insert Right g = E = 5 Lock Aspect Ratio
Table Rows & Columns Merge Cell Size Alignment Table Size
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Please do not redistribute these materials without the
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